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Analyzing Experiments Repeatedly 1 

 
This article includes the following techniques: 

 Linking analyses 

 Column math analysis 

 User-defined transforms 

 Using “Info Constants” 

 Creating a using templates 

 Saving and applying a method 

 Applying a method by example 

 

If you must perform the same analytical and graphing tasks many times, varying only the input data, Prism helps 
with a number of tools. Scripting, a means of automating data input and output via a simple programming 
language, is discussed in the Step-by-Step Example “Creating and Running a Prism Script”. Three manual 
techniques are covered in this article: 

 Templates allow you to duplicate an entire project in one step. You create the template the first time you 
set up the project, but store it without the data. To replicate your work, open the template, add the new 
data, and store the file under a new name. Or insert the template into another file. 

 Duplicating a family of sheets replicates your work within the same project file. Simply duplicate a sheet 
and all sheets linked to it—formatted graphs, analyses, info, and layouts—using a single Prism command. 
Then replace the input data for the duplicate family. 

 Applying a method effectively duplicates a family of sheets, but in this case, the replicated work can come 
from the same project or a different project. Add a new input data table, then either (a) apply a saved 
method or (b) point to another table in the project to apply by example all sheets linked to the latter. 

We’ll demonstrate these three techniques as applied to a family of linked sheets that produce a simple biochemical 
activity computation. To make it easier to see the linkage between sheets in the Navigator, open the Edit menu 
and choose Preferences…. In the Preferences dialog, select the View tab, and then activate the Data+Results 
view. 
                                                        
1 Adapted from: Miller, J.R., GraphPad Prism Version 4.0 Step-by-Step Examples, GraphPad Software Inc., San 
Diego CA, 2003. Step-by-Step Examples is one of four manuals included with Prism 4. All are available for 
download as PDF files at www.graphpad.com. While the directions and figures match the Windows version of 
Prism 4, all examples can be applied to Apple Macintosh systems with little adaptation. We encourage you to print 
this article and read it at your computer, trying each step as you go. Before you start, use Prism’s View menu to 
make sure that the Navigator and all optional toolbars are displayed on your computer. 
 
2003 GraphPad Software, Inc. All rights reserved.  GraphPad Prism is a registered trademark of GraphPad 
Software, Inc. Use of the software is subject to the restrictions contained in the software license agreement. 
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Quantifying Uptake into Cells  
Suppose you want to measure the effects of various inhibitors on uptake of a radiolabeled substrate into 
suspended cells. You have developed a method for removing aliquots at two times within the “linear” phase of 
uptake, quenching uptake in the aliquots, and measuring radioactivity in the cell fraction. You are testing a 
number of inhibitors on the same day using the same cell preparation.  

Creating the Data Table 
The variables recorded for each uptake measurement are 

 Radioactivity at the beginning of the uptake interval (CPMTime 1) 

 Radioactivity at the end of the uptake interval (CPMTime 2) 

Their values will be recorded on the data table. 

In the Prism Welcome dialog (if Prism is already running, choose File… New project…. Make the settings 
shown below. 

 

Enter the data on the resulting table. The X column holds test article names. One test article is evaluated on each 
line, with column A and column B holding duplicate radioactivity measurements made 3 minutes apart, at 10 sec 
and 190 sec after initiation of uptake, respectively. 

 

Type a name for this table in the box on the toolbar. 
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Creating an Info sheet 
Variables whose values change from experiment to experiment, but are constant within each experiment, are 

 Specific radioactivity of the uptake substrate (cpm/nmol) 

 Time interval over which uptake is measured (min) 

 Dry weight of cells in each aliquot (mg) 

These variables will be recorded in Prism as Info Constants. 

From the data table, click the New button and choose New Info…. In the Create New Info dialog, choose to 
link the Info page to the data table (Input data) we just created.  

In the Constant column of the Info page, make new entries for specific activity, uptake measurement interval, 
and dry weight of the cells in one aliquot. Wording isn’t critical—just use terms you’ll recognize later. 

 

In the Value column, enter the numbers shown. These are values are common to all measurements represented 
on the data table (Raw CPM). They will be used to perform the conversion and normalization of raw CPM values 
to uptake in nmol substrate/min/mg dry weight. 

Computing Uptake 
We will compute uptake as 

2 1Time TimeCPM CPM
Specific Activity Uptake Interval DryWeight

  −
 

 ⋅  ⋅  
 

We’ll compute this quantity for each pair of CPM measurements (CPM at 10 sec and CPM at 190 sec) on the 
original data table using two linked analyses. We’ll compute CPMTime 2 – CPMTime 1 using a Column Math analysis, 
then divide the results by the values for specific activity (SA in cpm/nmol), uptake interval (Time in min), and dry 
weight (in mg) found on the Info page using a User-defined Y transform.  

Column Math Analysis  
From the data table, click the Analyze button. In the Analyze Data dialog, choose Remove baseline and 
column math from the Data manipulations list. 

Prism performs a Column Math analysis by computing the differences between values in pairs of adjacent 
columns (A and B, C and D, etc.) all the way across a data table or Results sheet, ignoring empty cells, and placing 
the differences on a new Results sheet. In the Parameters dialog, indicate that the subtrahends (numbers to be 
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subtracted, also termed “baseline values”) are in column A. This means that Prism is to subtract values in columns 
A, C, E… from values in B, C, F… respectively. 

Complete the selections in the Parameters dialog as follows: 

 

When you leave the dialog, Prism creates a Results table to hold the differences. Note that the distinction between 
duplicate determinations has been maintained, and Prism has treated the replicates as “matched” per our setting 
in the Parameters dialog. 

 

Name this Results sheet: 

 

User-Defined Transform 
From this Results sheet, click Analyze. In the Analyze Data dialog, choose Transforms from the Data 
manipulations list. 
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In the Parameters: Transforms dialog, indicate that you will be using a user-defined Y transform. 

 

Click the Add… button to open the Equation dialog. Give your transform a name, and enter the transform 
equation in the Equation box, as shown below.  

 

The parameters “SpecAct”, “Time”, and “Weight”, on the right-hand side of the equation are arbitrary—use terms 
that make sense to you. We’ll specify their values in the next dialog. Click OK to return to the Parameters: 
Transforms dialog.  

Prism analyzes the user-defined transform and displays the three parameters that it finds. Click in the value box 
next to SPECACT, and choose SA (cpm/nmol) from the Link and Info Constant dialog. Fill in the values for 
TIME and WEIGHT similarly. 

 

Choose to Transform the average of replicates and check the box to Create a new graph of the results. 
A new Results sheet appears with the final transformed values. You can change the heading for column A to 
increase readability. 

 

Rename the Results sheet: 

 

Instead of applying one user-defined transform, you could do three successive divisions using the 
Y=Y/K transform from the Standard functions list, filling in the value for K from the Link an 
Info Constant dialog each time. That would avoid having to enter the user-defined transform 
and would allow you to see all intermediate values, but would also clutter the project with 
additional Results sheets.  
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Click the Graphs tab to view the graph of the transformed data. In the figure below, some additional editing has 
been done. You may be particularly interested in showing the baseline labels at an angle—double-click on the 
baseline to open the Format Axes dialog, make sure the X axis tab is selected, and choose angled labeling. 
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Templates 

Using a Template Alone 
The project file we just created will the basis for our template. Before saving a template, it’s usually a good idea—
although not strictly necessary—to erase any data on the table that will change during subsequent use of the 
template.  

Delete the values for specific activity, time, and dry weight on the Info page if you wish. This is not mandatory. 

 

Switch to the data table (“Input data”), select all data below the column headings. 
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Press the Delete key—don’t use the Delete command on the Edit menu; you want to maintain the data cells, but 
without the data. If you see a message that tells you about the data being linked to the graph, disregard it and click 
OK.  

Don’t switch to the graph at this point. That could break the link to the graph and cause the 
template not to work correctly. 

Place the cursor in the top cell (row 1) of the X column, then select File... Save Special… Save Template.  

Fill out the dialog box as shown below. Note that you may indicate here whether you wish the template to be 
stored on your computer or on another computer networked to it. You may also generate different categories 
under which templates are stored. The description at the bottom of the dialog is optional; this message will be 
displayed as an aid to any user opening the template. 

 

Now close the file, and we'll see how to use the template. 

Choose File...New Project to open the Welcome dialog. Set the radio button for a Template and select the 
template that you just created.    
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Click OK, and you'll get a new project formatted as your template. If you created a description, you will see it now. 
When you close the description box, the cursor should be at the top of the X column (note that the column 
headings are still there, if you didn't delete them before you saved the template). 

 

You can also insert a template into a project that you have open. With any data table in view, click the New button 
and then choose New Data Table (+ Graph)…. Choose Insert template and proceed as described above. 

Now enter some new data: 

 

Switch to the Info page and fill in or replace the values in the last three rows.  

 

Now switch to the Results page named nmol/min/mg to view the automatically updated uptake values, 
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then click on the Graphs tab to view the graph: 
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When you save your work, remember to use the File… Save As… command and give the file a new name. 

Inserting a Template into Another Project 
We have just covered one way to use a template—alone, opening the template with its empty table, filling the table 
with data to produce updated results, and storing the file under a new name. 

You may also insert a template into an existing file. Click the New button, then choose New Data Table 
(+Graph)…. In the Create New Table dialog, choose Insert template, change the template category if 
necessary, and select the template. The contents of the template are merged into the open file. 

Applying a Method 
If you use the same treatment (analyses or graphs, or both) with various data tables, try applying a method.  

Saved Method 
When you save a method, you can apply it later within the same project file or to another project file. From a data 
table that is linked to analyses and/or graphs that you wish to reproduce (you may use the template that we’ve 
created in this example), click File… Save Special… Save Method. Make entries in the Save Method dialog 
as shown below, and then click OK to save the method. 
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To use the method, start with the project file created earlier in this article (see “ ” 
earlier in this article) or a similar file. Add a new table, with new input data, and rename each data table so that 
they can be distinguished easily. The organization of the project file might look like this: 

Quantifying Uptake into Cells

 

With the new table selected, click Analyze. In the Analyze Data dialog, choose to use a saved method, then 
select the category and specific method. If desired, enter a description of the method and a text string to be 
prefixed to the names of each newly generated sheet.  
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Click OK to apply the method to the data table you selected earlier. Prism applies the analyses and generates a 
new graph based on the new data.  

 

If any of the information is to be amended on the info page (including the date), do that now, then display the 
appropriate Results sheets and graph to verify that the results have been updated. 

Method by Example 
If you wish to apply to a data table work that is associated with another data table in the same project, you can 
apply that work by example. Let’s return to the project file in the previous section as it appeared before applying 
the saved method (at that point we had just created the new data table “Sept 9 input data” and entered new data 
on that table. 
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Click Analyze, then choose Method by example. Select the data table to which the method (analyses and 
graph) is linked, i.e., indicate the desired method by pointing to an example of its application. At the bottom of the 
dialog, provide a distinguishing prefix for the new sheet names if desired. 

 

When you exit this dialog, Prism applies the analyses and creates a new graph, just as it did when the saved 
method was applied. 
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